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Introduction 
 
Unipart Dorman DF11 is an LED Speed Feedback Sign designed to provide a clear concise 
warning message to drivers that they are travelling above a predetermined safe speed 
threshold.  
 
There are six sign variants:  
 
DF11MC - DF11 Mains Charger version 
 
DF11SC - DF11 Solar Charger version 
 
DF11MCB - DF11 Mains Charger version with Bluetooth data transfer facility 
 
DF11SCB - DF11 Solar Charger version with Bluetooth data transfer facility 
 
DF11MC-T - DF11 Mains Trickle Charge version 
 
DF11MCBT - DF11 Mains Trickle Charge version with Bluetooth data transfer facility 
 
The LED display is equipped with an automatic brightness control and this manages the 
power usage to conserve battery life. When no traffic is present, the display remains blank to 
further limit power consumption. 
 
When a vehicle approaches the sign which exceeds the low speed threshold value (set to 
prevent cyclists etc. from triggering the sign erroneously), the display will indicate the 
approaching vehicle speed. Where the speed is in excess of the limit placed on the road, the 
display will continue to feedback the speed but will flash at 1 Hz to warn the driver they are 
breaking the speed limit. If the vehicle speed is greater than a preset top limit the display will 
go blank.  
 
The signs can be specified with a time stamped speed data logging and analysis feature 
which is available during the initial purchase phase or can be added later if required by 
contacting Unipart Dorman. This facility has proved to be useful in generating effectiveness 
reports and the data can be supplied to enforcement authorities to tailor an enforcement 
campaign.   
 
There are a number of power supply options available including an internal LIFePO4 battery 
pack connected to a mains charger using the multi-function plug at the bottom of the unit; or 
for more permanent locations a solar panel which feeds the battery pack from a separate 
cable which runs into a cable gland at the rear of the sign. The solar versions also have a top 
up charging facility using the multi-function plug at the base of the unit.  In areas of poor 
solar capture or extremely high traffic volumes, a feed can be taken from the street lighting 
column to trickle charge the sign during the hours of darkness and ensure the batteries have 
sufficient capacity available. 
 
A retro-reflective ‘YOUR SPEED’ fascia plate is usually added to the front of the sign and this 
can also be ordered with bespoke logos and or messages shown on the reflective surface. 

 
 
 
 
 
 
 



 
 
 

P a g e  | 3 
 

C64.64156  Issue 3 Sep 2018 
 

Interactive Online Tutorial 
 
There is an excellent tutorial supplied with the Houston Software and this can be found by 
clicking on the ‘Help’ tab of the Houston Radar launch screen as shown: 
 

 
 

Important Information 
 
Please review the following information before operating this device. 
 
READ ALL INSTRUCTIONS BEFORE USE AND SAVE THIS MANUAL FOR FUTURE 
REFERENCE 
 
DF11 units must be only be installed and operated in accordance with the 
instructions contained in this Handbook.  
 
Changes or modifications not expressly approved by Unipart Dorman could void 
any warranty or guarantee on the equipment.  
 
If the sign is installed by anyone other than the Unipart Dorman installation team, 
Unipart Dorman accepts no liability for any failures caused by the mounting or 
connection of the signs, including any calculations and/or specifications related to 
the mounting post or any associated foundations.   
 

Safety Information 
 
The following safety information and warnings enable you to avoid potential harm to yourself 
and others; and possible damage to the equipment being operated and its surrounds. 
 
It should not be considered as an exhaustive list of hazards you may encounter and should 
never be considered as a substitute for your judgment and experience and/or formalised risk 
assessment/hazard management protocols. If you are unsure about any part of these 
instructions or of the potential hazards listed, please contact Unipart Dorman immediately 
using the details at the back of this handbook. 
 
 
Please read and observe all safety information and instructions in this manual 
before operating any equipment. You should keep this handbook in a safe place 
for future reference. 
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Customers are required to ensure that all National and Local regulatory 
requirements are fully complied with prior to and during the installation and also 
in the day to day operation of the equipment.  
 
Use the DF11 only for the applications it was designed and supplied for.  
 
Changes or modifications not expressly approved by Unipart Dorman could void 
any warranty or guarantee on the equipment.  
 
Whilst the unit is designed to be robust and resistant to damage, like all electronic 
equipment, care should be exercised when moving the sign to ensure that heavy 
blows/impacts are avoided.  
 
Please read all the following safety advisory messages before carrying out any 
work on this equipment. 
 
WARNING 

To reduce the risk associated with electric shock injury. 
 
Do not try to open the sign; there are no user serviceable parts inside the unit.  
 
Ensure that the electrical supply is isolated from the power input lead before 
disconnecting it from the sign during charging. 
   

WARNING 

Radar RF energy can be harmful to the eyes.  
 
To reduce exposure to the risk of RF energy, do not stare into the sign window. 
Keep a minimum safe distance of 20cm (8-inches) from the display face. 
 
It should be noted that this equipment is battery operated and can at times 
transmit RF energy even when the sign display is blank and the sign appears to be 
disconnected from a power supply 
 

AG 

To reduce the risk of impact hazards resulting from falls, accidents with passing vehicles, and 
from unstable equipment: 
 
Use appropriate Traffic Management methods, equipment, and implement safe 
working procedures. 
 
Strain or back injury may result from lifting equipment incorrectly.  
 
To reduce the risk of strain or back injury, always use proper lifting techniques 
and have adequate help.  
 
To avoid the possibility of injury due to falling or unstable equipment: 
 
Be certain the sign is mounted to an appropriately rated pole or equivalent 
mounting surface. 
 
Use appropriately rated mounting hardware. 
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Installation of DF11 and associated hardware may require that you work above 
the ground on a ladder or access device. Please make sure you have all the 
required equipment and are aware of potential safety issues before starting any 
installation.  
 
DO NOT install any DF11 hardware if you are unsure how to complete the 
installation or lack appropriate safety equipment.  

 
NOTICE 
This equipment has been tested and found to conform to the European Union EMC 
Directive 2004/108/EC.  
 
This equipment generates, uses, and can radiate radio frequency energy and if not 
installed and used in strict accordance with the instructions provided, may cause 
harmful interference to radio communications.  
 
Changes or modifications to the equipment supplied not expressly approved by 
Unipart Dorman could compromise the EMC integrity of the device and invalidate 
any warranty. 
 
Every care is taken to ensure that, as far as reasonably practical, the sign will perform 
without risk to health and safety. If you are in any doubt with respect to these instructions, 
please consult Unipart Dorman before proceeding.  
 
Please note that equipment and components described in this document may be protected by 
patent and no part of this document may be reproduced in any form without the written 
permission of Unipart Dorman.  
 
Unipart Dorman reserves the right to vary or modify any specification without prior notice. 

INSTALLING THE SIGN 
 
Prior to any installation work commencing it is highly recommended that the installer 
undertakes a site survey evaluation and a full health and safety risk assessment covering 
installation, operation and maintenance.  
 
The DF11 comprises 2 main assemblies - the Sign and the Adaptor Plate which it fixes to. The 
Sign is designed to be quickly detachable from the Adaptor Plate; and this allows the 
purchase of a number of Adaptor Plates which can be permanently fixed and a single sign 
rotated amongst them to maximize impact on drivers.    

 
The optimum alignment of the sign face is pointing at the centre point of the approach traffic 
lane(s) and at a distance of between 300ft (90m) and 500 ft. (150m) from the sign. The sign 
should be mounted no less than 5 feet (1.5m) above the surface to ensure maximum radar 
performance. Unipart Dorman recommends a minimum height of 7 feet (2.17m) 
 
The Sign is mounted onto a quick release mounting plate using 3 robust steel mushroom 
head locating pegs which locate into keyhole slots. It is secured to the mounting plate using a 
standard padlock.  
 
The adaptor plate is supplied with Signfix Channelling as the mounting hardware and 
customers can choose the best option for fixing the mounting plate to the post by consulting 
the Signfix catalogue. 
 
When fitted, the adaptor plate completely covers the on/off switch to prevent malicious 
operation. The rotary switch however is still accessible using the key.     
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Sign Mounting Hardware (showing a representative padlock) 

Charging the sign 
 
Both solar and mains charged signs need a full charge cycle prior to the first deployment. A 
full cycle will take approximately 8 – 12 hours.  
  
The external charger simply plugs into the multi-function socket at the bottom of the sign. 
Whilst the sign is charging, the red LED on the charger is illuminated. When the battery pack 
is charged to capacity this LED will go green. 
 
 

 
 

 
 
Please note:  
 
The DF11 battery pack contains Lithium Iron Phosphate (LiFePO4) which is a rechargeable 
battery and like any rechargeable batteries, they need to be exercised by placing the sign 
through a full charge – discharge – full charge cycle every few months. 
  
If the sign is to be placed in long term storage which in this case means anything in excess of 
6 weeks the battery should be fully charged before storage and then exercising the battery 
every 3 months.  If this schedule is not adhered to, it is possible that the battery could self-
discharge to a point where it could not be "revived" even after being charged.   
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Charger Variants 
 
The mains and solar versions of the sign each have their own version of the same Tenergy 
Battery Charging Pack. The solar powered version has a 2 Amp 9.6 Volt charger (3 Cell 
battery Pack) and the 240V mains charged version has a 1.5 Amp 12.8 Volt charger (4Cell 
battery Pack). Care must be taken to ensure the correct charger is used as the chargers are 
visually identical except for the label.  The pin arrangement in the multi-function plug is 
specifically designed to prevent cross connection and if the sign does not appear to charge 
the first thing to check is that the correct charger is used. 
 

 
 
 

Remember: 
 
 Solar = 3 Cell Charger 
 
 Mains = 4 Cell Charger 
  

Operating the sign 
 

Turn on the power to the DF11 by using the grommet switch located on the back of the unit 
(One push/click for on and a further push/click for off). When the sign is turned on, it will 
enter a brief self-test mode where the digits display will count up from 1 to 9, flash 88 and 
then go blank. The self-test is complete and the sign is now ready for use. A small yellow LED 
will illuminate in the middle of the sign to indicate it is on.  
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Please note that the switch is covered by the adaptor plate when the sign is fitted to it. This 
security feature prevents malicious operation. 

Introduction to Speed Setting 
 
Typically, users set the trigger speed at or just above the speed limit on the road 
and the high-speed display cut off at a speed sufficiently above the speed limit to capture 
most of the speeding traffic but not high enough to encourage “racing against the radar”. A 
low cut off value is also set which only enables the display if the target exceeds this setting, 
and is used primarily to filter out low speed traffic such as bicycles etc. thus preserving 
battery life. 
 
For example, for a 30mph speed limit road, the violator limit may be set to 31 mph and 
the low and high cut offs will be set 15 mph either side of this value. (Increasing the Low Cut 
Off Speed to closer to the trigger speed value will greatly improve battery life).  
 
Where enabled, connection can be made by either a cable or Bluetooth method and this is 
covered later in this document. 
 
If the rotary speed switch is enabled (see later section on manually setting speed 
parameters), turn the speed switch to the desired position (0 - 7) to select preset speed 
values in the sign.  
 

Installing the Stats Analyser on your PC/Laptop 
 
Please visit http://www.unipartdorman.co.uk/df11-software.html and download the Stats 
Analyser software: 
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The software should auto load and you will be presented with the following screen during the 
loading process: 
 
 

 
 
Please accept any requests the software makes for ‘changes to your computer’ and then click 
on Close when the Installation is complete. 
 
The Stats Analyser will place an icon on your desktop and double clicking this will launch the 
analyser: 
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Pairing Your Laptop with a Bluetooth Dongle  
 

If your PC does not have an internal Bluetooth device you will need to connect a USB Dongle 
to allow your Laptop to communicate with the sign. Whilst most Bluetooth dongles are simply 
Plug & Play others require configuring to your device and this section describes how to do 
this. The maximum operable distance between your device and the sign is based upon your 
Bluetooth devices capability, but as a general rule this will be less than 10m. 
 
After starting your Laptop make sure all programs are closed and insert the dongle into a 
convenient USB port. If the dongle is recognised and the drivers install automatically, please 
wait until a message telling you that your device is ready for use appears and then go 
straight to ‘Connecting to the sign using built in Bluetooth’. 
 
If the drivers fail to install and the dongle came with an installation CD: 
 
• Remove the Bluetooth dongle from the USB port. 
• Insert the CD and follow the manufacturer's instructions to install the software drivers. 

During this installation you may be prompted to Re-insert the Bluetooth dongle. 
• Wait for installation to complete 

Insert the Bluetooth dongle, Windows should detect and install the Bluetooth hardware once 
this is complete switch on the DF11. 
 
Locate the Bluetooth icon in the system tray near the clock, in Windows 7 or above the Icon 
may be hidden just click the small triangle pointing upwards to reveal hidden icons.  
 
  
 
 
 
 
 
 
 
 
 
Right click on the icon, then click ‘Add a Device’  
and select your device on the next screen. Then click Next  
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Pair the device using the next two screens and enter the pairing code 1234 (or 0000 on 
older models) 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The code will be either 0000 or 1234 depending on the Bluetooth version supplied 
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To obtain the outgoing COM port, right click on the Bluetooth icon in the in the system tray 
and then ‘Open Settings’ 

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
Under the COM Ports tab make a note of the Outgoing Port identity (it will usually have the 
‘Dev B’ legend against it). You will need this in the next section  
 

 
 
Your device should now be set up and ready to connect to the sign. 
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Connecting to the sign using built in Bluetooth 
 
 
There are many different combinations of built in Bluetooth hardware available and you must 
ensure that you have followed your PC manufacturer’s instruction carefully regarding the 
setting up of Bluetooth on your device. If the device requires you to enter a pairing code, 
please enter 0000 or 1234  depending on the Bluetooth variant installed. 
 
Ensure that you have the latest version of Stats Analyser fitted to your device and the 
Bluetooth is operational and within pairing range (depending on your Bluetooth devices 
capability but as a general rule this will be less than 10m). Launch the analyser and select 
‘Connect to Radar’ 
 
 

 
 

 
Then you will need to select which COM Port on your device which your Bluetooth is 
configured to use. If you know already please select it from the dropdown as shown, or if not 
select Auto Detect Port.  
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If you select Auto Detect the system will try each port individually to detect the Bluetooth 
Device and this could take some time to achieve. As soon the system has connected with the 
radar a dialogue box will confirm the system setting information and then a Radar Found Pop 
Up will appear.  You can clear these boxes by clicking OK. (You may wish to note the COM 
Port used to speed up future connection processes): 
 

 
 

 
 

The Radar Found box will display a data transfer speed, it should be noted that these speeds 
are variable depending on a number of different things. However, if you feel the data transfer 
speed is excessively slow, please contact Unipart Dorman for advice.  
 
Successful connection to the sign is shown by the legend shown at the bottom of the screen. 
 

 
 
 
Please note that the pop up boxes may appear behind the screen you are currently viewing if 
you have more than one application running. This can mean that anything you try to click 



 
 
 

P a g e  | 16 
 

C64.64156  Issue 3 Sep 2018 
 

onto when in the Houston screen will be inactive until you have cleared the pop up boxes by 
clicking on their OK button. 
 

Connecting to the sign (Cable Entry) 
 
 

 
 
 

The DF11 features a standard cable interface that can be used to configure the display and 
download captured speed data onto a Laptop/PC running the Stats Analyser software. The 
cable plugs directly into the multi-function socket located on the base of the unit. The cable 
only needs to be finger tight and any excess force applied will result in damage to the 
connectors, which may not be covered by any warranty. 
 
Connect the cable as shown above and then run Stats Analyser by double clicking the icon 
previously installed on your desktop using the instructions above.  
 

 
 
 
 
 
 
 
 

This space intentionally blank 
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CONFIGURING THE SIGN 
 

Setting the Sign’s Internal Clock 
 

Before synchronising the clocks, please ensure the computer you are using is 
displaying the correct time value. Your computer user manual should give you 

instructions on the correct way to set the time. 
 
It is recommended that the radar clock is synchronised to the computer time setting at each 
sign connection as this will keep the sign software calibrated. This is carried out by simply 
clicking on the ‘Sync Radar Clock to Computer’ button. Synchronisation is complete when the 
Radar Clock Value (shown ringed) is the same as the computer time as shown in the bottom 
right of your screen.  
 

 
 
 
 
 
 
 
 
 
 
 

This space intentionally blank 
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Setting the Speeds 
 
Select the Radar Set Up tab and the PNL10 Setup tab. Alterations to the values can be made 
by either the dragging the cursor along the speedline or altering the values in the boxes. 
 
The trigger speed setting is set using the red Speed Limit Box/Red Cursor and the upper and 
lower speed limits are set using the green Minimum/Maximum Display Speed boxes/Green 
Cursors. Once the settings are made please click on the ‘Write to Radar’ box to transfer the 
new settings to the sign 

 
 

 
 
 

The Minimum setting should be set sufficiently high to prevent the sign being triggered by for 
example a jogger approaching the sign, but low enough to capture approaching motor 
vehicles. Careful consideration of this value will allow the sign to create the maximum impact 
but preserve battery life as much as possible. 
 
The Maximum setting is a value which when exceeded will cause the display to go blank.  
 
 
 
 
 
 
 

This space intentionally blank 
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Manual Adjustment of Trigger Speed setting 
 

Manual adjustment is useful on signs which are moved frequently between locations and 
where each individual place has a different set of criteria for speed setting. The 8 different 
presets available mean that the speed parameters can quickly be set without connecting a 
computer to the sign via Bluetooth or cable. Initially Position 0 is set as a datum and each 
click of the switch will increment the speed settings by the value shown in the ‘Rotary Speed 
Switch Increment’ box. 
 
  
The sign is set to the following values in the factory: 
 

Switch Position Min Display Speed Speed Limit Max Speed Cut Off 
0 3 5 30 
1 8 10 35 
2 13 15 40 
3 18 20 45 
4 23 25 50 
5 28 30 55 
6 33 35 60 
7 38 40 65 

 
 
 
To adjust the values first click on the ‘Enable Rotary Switch’ button and ensure that there is a 
tick in the box 
 

 
 
Clicking on ‘Adjust Limits’ will enable the speed parameter boxes to be altered and set for 
position zero on the rotary switch. Then define the increment that the speed settings will 
change by for every click of the switch by setting the value in the Rotary Speed Increment 
box. So for instance if you wanted the speeds to increase 5 MPH for every click of the rotary 
switch, you would enter five in the Rotary Speed Increment box. Use the Test Rotary Switch 
Position box to cycle through the seven remaining switch selections to see the values set for 
each switch position.  
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The ‘Check Limits’ selection allows the user to cycle through the parameters already set into 
the sign.  
 

 
 
 
Clicking the ‘Display Speed Limits Table’ button will bring up a handy table showing the 
parameters each rotary switch position is set to. This can be printed and kept with the sign if 
required. 
 

 
This space intentionally blank 
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To change the speed settings manually, remove the bung covering the access port and insert 
the Unipart Dorman Adjustment tool to adjust the spindle, where each click is the next switch 
position. When the switch has been turned fully anticlockwise it will be at the zero setting. Do 
not use excessive force during adjustment. 
 
Please note that if the Enable Rotary Switch box is not ticked, manual adjustment is not 
possible. 
 
Once the adjustment is complete, remove the tool and re-insert the bung. Failure to re-insert 
the bung correctly will compromise the IP rating of the sign, and any moisture ingress or 
subsequent damage may invalidate any warranties applied. 
 
 

 
 

Adjustment Tool fitted 
 
 

 
Manual Speed Adjustment Tool (Unipart Dorman Part Number C62.62025) 

 
 
 
 

 
 

Bung fitted correctly after adjustment 
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Detection and Units Tab 
 

This tab allows users to select between MPH and KPH and also the mode that the radar 
performance is set in. The sign will be factory set at 100% sensitivity and the traffic will be 
detected as the fastest inbound targets. It is not anticipated that there will be any need to 
alter these settings. Please consult Unipart Dorman before any alterations are made. 
 

 
 

Data Output/Hardware & IO Config Tabs  
  

 
 
The settings in these tabs are factory set. If any of the values are altered without first 
consulting Unipart Dorman, the performance of the sign may be severely degraded and could 
result in the sign being returned to works for resetting, which would be outside any warranty 
agreements.  
 

 

DATALOG FACILITY 
 
The DF11 has an optional datalog facility which allows the capture of sign activation statistics 
and the generation of spreadsheets and graphs to allow users to monitor the sign’s 
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effectiveness, especially where it is deployed in a variety of locations. It is possible to 
generate average data by hour for each day of the week and also view weekly and monthly 
averages.  
 

Open a Project 
 
Prior to downloading the data from the sign you need to set up a new project which will 
contain all the data and provide the tools necessary to manipulate it into reports and graphs. 
Click on File>New/Open Stats Project and then as shown click on new project and then enter 
a name for the project in the pop up box, which could be for example the sign location and 
download date. 
 

 
 

Click on OK and then on the next screen select the project required and then select Open. If 
you are not already connected to the sign via Bluetooth or cable, you will be prompted to do 
so. 
 
If you wish to work with a previous project, simply select the project from the list and click on 
Open.  
 

Obtaining the Radar Stored Data 
 
Return to the Connection tab on the launch page and after checking that the sign is still 
connected, click on the ‘Read Get Traffic Stats from Radar’ Button as shown in the illustration 
below. The radar will then start to download the data to the folder you choose in the pop up 
dialogue box. The speed and progress of the download is displayed in the Traffic Stats Info 
section in the bottom right of the screen.  
 
Some clients find it useful to delete the data stored in the sign after download as this will 
speed up the next download.  
 
ONCE THE DATA IS ERASED FROM THE SIGN IT CAN NOT BE RECOVERED 
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Working with the Data 
 
The following screenshots provide a self-explanatory guide to the processes required to 
generate and print reports in various formats: 
 
 

 
 

The Monthly Counts/Speed Avgs tab shows in a weekly view the average counts or speeds 
for a specific hour segment averaged over an entire month. The values highlighted in Orange 
show the highest speed for the timeframe selected. Available months are shown and selected 
in the drop down circled in red on the picture above. 
 
The Weekly Counts tab shows the same information but averaged across one week and 
again, the week is selected using the dropdown circled in red. 
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Generating Charts and Graphs  
 

 
 

Selecting one of the three Chart tabs highlighted above will give speed and volume graphs 
depending on which tab is selected. 
 

 
 

Selecting File>Print will allow you to make a hardcopy of the graph or copy it onto the 
Windows Clipboard and then paste into any Microsoft Office Programme. 
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SERVICING THE SIGN 
 
It is recommended that routine maintenance is carried out at six monthly intervals as detailed 
below. This period may need adjusting depending on the conditions of use and should be 
revised after each maintenance visit. 

 

Battery Husbandry 
 
The DF11 battery pack contains Lithium Iron Phosphate (LIFEPO4) which is a rechargeable 
cell and in common with other rechargeable batteries, they need to be exercised by placing 
the sign through a full charge – discharge – full charge cycle. Unipart Dorman recommends 
that this process is carried out every few months if normal operational usage means that the 
battery pack is only ever partially discharged/charged. 
  
If the sign is to be placed into long term storage (which in this case means anything in excess 
of 6 weeks),  the battery should be fully charged before storage and then exercised every 3 
months.  If this schedule is not adhered to, it is possible after an extended period in storage 
that the battery pack could self-discharge to a point where it could not be "revived" even 
after being charged.   

 

Visual Check 
 
Visually check the enclosure and screen for damage, paying particular attention to any 
external cabling, specifically checking for security of attachment.  

Enclosure Cleaning 
 
Clean the enclosure and front screen with a cloth and mild detergent solution. Abrasive 
materials or solvent based cleaners should never be used.  
 

Radar Performance 
 
If there are problems where the sign is triggering late or fails to trigger when the 
approaching vehicle is clearly exceeding the set speed, consideration should be given to 
clearing all significant radar energy reflectors from within the radar footprint. Please contact 
Unipart Dorman Varitext for further advice.  

End of Life Recycling 
 
All components in the DF11 are designed with End of Life Recycling in mind. Neither the sign 
nor any of its component parts should not be disposed of as standard waste, this is 
particularly important with regard to the battery pack as it contains small amounts of Lithium.  
 
Please contact Unipart Dorman for the very latest instructions and methods of disposal.   
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